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Preface

The UltraTMEnterpriseTM 10000 SSP 3.0 User’s Guide describes the SSP (System
Service Processor), which enables you to monitor and control the Enterprise
10000 system.

Who Should Use This Book
This manual is intended for the Enterprise 10000 system administrator. Sun
MicrosystemsTM assumes that users of the Enterprise 10000 system have a
working knowledge of UNIX® systems, particularly those based on the Solaris
operating environment. If you do not have such knowledge, you should first
read the SolarisTM User and System Administrator AnswerBooks provided
with this system, and consider UNIX system administration training.
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How This Book Is Organized
This document contains the following chapters and appendices:

Chapter 1, “Introduction,” introduces the System Service Processor (SSP).

Chapter 2, “Overview of the SSP Tools,” introduces Hostview and
netcontool(1M) .

Chapter 3, “System Administration Procedures,” describes how to perform
common system administration procedures.

Chapter 4, “SSP Internals,” provides more detailed information for system
administrators interested in how the SSP works. Included are descriptions of
the SSP booting process and the edd(1M)  daemon which monitors the Ultra
Enterprise 10000 system.

Appendix A, “Glossary”

Related Documentation
Other documents that describe the Ultra Enterprise 10000 server, the SSP, and
the related Dynamic Reconfiguration and Alternate Pathing features, include:

• Ultra Enterprise 10000 SSP Reference, part number 805-0077-10

• SSP 3.0 Software Upgrade Installation and Product Notes, part number
805-0521-10

• SMCC Open Issues Supplement, Solaris 2.5.1 Hardware:4/97, part number
802-7683-10.  A printed document in your media box,, this book contains
Ultra Enterprise 10000 product notes and upgrade installation instructions,
if any in the section, “Ultra Enterprise 10000 Servers”.

• Dynamic Reconfiguration User’s Guide, part number 805-0080-10

• Dynamic Reconfiguration Reference Manual, part number 805-0081-10

• Alternate Pathing 2.0 User’s Guide, part number 805-0082-10

• Alternate Pathing 2.0 Reference Manual, part number 805-0083-10

• Alternate Pathing 2.0 Installation and Product Notes, part number
805-0522-10



Preface xi

Ordering Sun Documents
The SunDocsSM program provides more than 250 manuals from Sun
Microsystems, Inc. If you live in the United States, Canada, Europe, or Japan,
you can purchase documentation sets or individual manuals using this
program.

For a list of documents and how to order them, see the catalog section of the
SunExpress™ Internet site at http://www.sun.com/sunexpress .

What Typographic Changes Mean
The following table describes the typographic changes used in this book.

Table P-1 Typographic Conventions

Typeface or
Symbol Meaning Example

AaBbCc123 The names of commands,
files, and directories;
on-screen computer output

Edit your .login  file.
Use ls -a  to list all files.
machine_name% You have mail.

AaBbCc123 What you type, contrasted
with on-screen computer
output

machine_name% su
Password:

AaBbCc123 Command-line placeholder:
replace with a real name or
value

To delete a file, type rm filename.

AaBbCc123 Book titles, new words or
terms, or words to be
emphasized

Read Chapter 6 in User’s Guide.
These are called class options.
You must be root to do this.
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Shell Prompts in Command Examples
The following table shows the default system prompt and superuser prompt
for the C shell, Bourne shell, and Korn shell.

Table P-2 Shell Prompts

Shell Prompt

C shell prompt machine_name%

C shell superuser prompt machine_name#

Bourne shell and Korn shell
prompt

$

Bourne shell and Korn shell
superuser prompt

#
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Introduction 1

The System Service Processor (SSP) is a SPARC® workstation that enables you
to control and monitor the Ultra Enterprise 10000 system. The SSP software
packages must be installed on the SSP workstation. In addition, the SSP
workstation must be able to communicate with the Ultra Enterprise 10000
system over an Ethernet connection. In this document, the SSP workstation is
simply called the SSP.

The Ultra Enterprise 10000 system is often referred to as the platform. System
boards within the platform may be logically grouped together into separately
bootable systems called Dynamic System Domains, or simply domains. In the
current release, up to five domains may exist simultaneously on a single
platform. (Domains are introduced in this chapter, and are described in more
detail in “Domains” on page 3-15.) The SSP enables you to control and monitor
domains, as well as the platform itself.

This document describes the SSP and the system administration functions it
provides.

SSP Features
The SSP uses the SPARC architecture and runs Solaris 2.5.1 in an
OpenWindowsTM/Open Look environment.

The SSP enables the System Administrator to perform the following tasks:

• Boot domains.
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• Perform emergency shutdown in an orderly fashion. For example, the SSP
software automatically shuts down a domain if the temperature of a
processor within that domain rises above a pre-set level.

• Dynamically reconfigure a domain so that currently installed system boards
can be logically attached to or detached from the operating system while the
domain continues running in multi-user mode. This feature is known as
Dynamic Reconfiguration and is described in the Dynamic Reconfiguration
User’s Guide. (A system board can easily be physically swapped in and out
when it is not attached to a domain, even while the system continues
running in multi-user mode.)

• Create domains by logically grouping system boards together. Domains are
able to run their own operating system and handle their own workload. See
“Domains” on page 3-15.

• Assign paths to different controllers for I/O devices which enables the
system to remain up in the event of certain types of failures. This feature is
known as Alternate Pathing and is described in the Alternate Pathing 2.0
User’s Guide.

• Monitor and display the temperatures, currents, and voltage levels of one or
more system boards or domains.

• Control fan operations.

• Monitor and control power to the components within a platform.

• Execute diagnostic programs such as POST (power-on self test).

In addition, the SSP environment:

• Warns you of impending problems, such as high temperatures or
malfunctioning power supplies.

• Notifies you when a software error or failure has occurred.

• Automatically reboots a domain after a system software failure (such as a
panic).

• Keeps logs of interactions between the SSP environment and the domains.
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Enterprise 10000 System Architecture
The Enterprise 10000 platform, SSP, and other workstations communicate over
Ethernet as shown in Figure 1-1.

Figure 1-1 Enterprise 10000 System and Control Boards

Redundant control boards are supported within the Enterprise 10000 platform.
Each control board runs a Control Board Executive (CBE) that communicates
with the SSP over the network. One control board is designated as the primary
control board, and the other is designated as the alternate control board. If the
primary control board fails, you can manually switch to the alternate control
board as described in “Dual Control Board Handling” on page 3-29.

SSP operations can also be performed by remotely logging in to the SSP from
another workstation on the network. Whether you login to the SSP remotely or
locally, you must login as user ssp  and provide the appropriate password if
you wish to perform SSP operations (i.e., monitor and control the platform).

WS

Enterprise 10000

CBE Control
Board 0

CBE Control
Board 1

SSP

Ethernet

Platform

SSP

WS

Enterprise 10000
platform

CBE Control
board 0

CBE Control
board 1

Ethernet
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SSP User Environment
You can interact with the SSP and domains in several ways, as described in the
following subsections.

SSP Window

An SSP Window is a window into the Solaris and SSP environments of the SSP.

Figure 1-2 SSP Window

To bring up an SSP Window, you must login as user ssp  and enter the ssp
user password. You are then prompted for the name of a domain. The
SUNW_HOSTNAME environment variable is set to that domain. (You can change
the value of SUNW_HOSTNAME at any time, if you wish.) The effect of
SUNW_HOSTNAME on client applications and daemons is described in “Instances
of Client Programs and Daemons” on page 2-2.

It is also possible to bring up an SSP Window on any workstation on the
network by using rlogin(1)  to remotely log in to the SSP machine as user
ssp . The DISPLAY environment variable must be set to your display, and your
xhost(1)  settings must enable the SSP software to display on your
workstation.

Multiple SSP Windows can be used simultaneously.

SSP or Other Workstation Display

SSP

SSP Window

% rlogin ssp \
-l ssp

SSP

SSP or Other Workstation Display

% rlogin ssp \
-1 ssp

SSP window
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SSP Console Window
The SSP Console Window is the console for the SSP machine.

Figure 1-3 SSP Console Window

This window is normally created when OpenWindows starts but, if necessary,
you can restart it via cmdtool(1)  with its -C  option. This window displays
messages from programs running in the SSP and its Solaris environment and
kernel.

SSP Display

SSP

SSP Console Window

% cmdtool -C
SSP% cmdtool —C

SSP Display

SSP Console Window
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Network Console Window

A netcon(1M)  window receives system console messages from a domain.

Figure 1-4 netcon(1M)  Window

Multiple netcon(1M)  windows can be open simultaneously, but only one at a
time can have write privileges to a specific domain. When a netcon(1M)
window is in read-only mode, you can view messages from the netcon(1M)
window, but you cannot enter any commands. For more information, see the
netcon(1M)  man page.

Enterprise 10000 Platform

Domain 1

Domain 2

SSP

netcon(1M)
Windows

Network

Logical Connection

Logical Connection

% netcon

% netcon

SSP
Network

Logical Connection

Logical Connection

% setenv SUNW_HOSTNAME domain1
% netcon

% setenv SUNW_HOSTNAME domain2
% netcon

netcon (1M) Windows

Enterprise 10000
Platform

Domain 1

Domain 2
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Hostview

The Hostview program provides a graphical user interface (GUI) with the
same functionality as many of the SSP commands:

Figure 1-5 Hostview GUI Program

Hostview is introduced in Chapter 2, “Overview of the SSP Tools” and is
described in more detail in Chapter 3, “System Administration Procedures”. It
is also described in hostview(1M)  in the Ultra Enterprise 10000 SSP Reference.

Using a Spare SSP
The SSP unit is a Sun workstation with a defined hardware configuration. Any
identical Sun workstation can also serve as an SSP. You can optionally
designate such a Sun workstation as a spare SSP unit, to serve as a backup in
case your primary SSP unit fails. You can also order your Ultra Enteprise 10000
server with a spare SSP unit. The spare SSP can be a dedicated spare SSP or a
non-dedicated spare SSP.

A dedicated spare SSP is a unit that you maintain in a ready state; if the
primary SSP fails, you can quickly switch to the spare SSP. The dedicated spare
SSP is not used for any other purpose. A non-dedicated spare SSP is one that
you do not necessarily maintain in a ready state, one that may require a re-
install of the operating system and SSP software before you can begin using it
as the SSP, should the primary SSP fail. However, you may use a non-
dedicated SSP for other purposes in the meantime.

Enterprise 10000 Platform

Domain 1

Domain 2

SSP
Network

Logical Connection

Logical Connection

Hostview

SSP Window

% hostview

SSP
Network

Logical Connection

Logical Connection

% hostview
SSP Window

Enterprise 10000
Platform

Domain 1

Domain 2

Hostview
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Use of a spare SSP requires adherence to the following requirements:

• The hardware for the spare SSP must be identical to the hardware for the
main SSP. (A spare SSP purchased from Sun satisfies this requirement.)

• The operating system and SSP software on the spare SSP must be identical
to the operating system and SSP software on the main SSP before the
changeover. If you are maintaining a dedicated spare SSP, you must install
the same operating system upgrades and patches on it as you do on the
primary SSP.

• If you are maintaining a dedicated spare SSP, you must not install or use
any non-SSP software on it.

• The main SSP must be backed up regularly. You should perform weekly full
backups and daily incremental backups. After any system configuration
operation, you should immediately perform an incremental backup in case
the main SSP crashes prior to the next scheduled daily incremental backup.
System configuration operations include:
• Changing the primary control board
• Inserting or removing a board via Hot Swap
• Attaching or detaching a board
• Creating, removing, or renaming a domain
• Performing a bringup operation on a domain
• Rebooting a domain
• Automatic domain recovery operations due to events such as system

panics or hardware failures

To switch over to the spare SSP, see the following sections in the Ultra
Enterprise 10000 System Service Processor 3.0 Installation Guide, which is included
in the Ultra Enterprise 10000 service document set:

• Replacing the SSP with a Dedicated Spare SSP

• Replacing the Main SSP with a Non-dedicated Spare SSP
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Documentation
For general system administration information, such as adding users and
mounting file systems, refer to the Solaris 2.5 System Administrator AnswerBook.
In case of conflicts, Ultra Enterprise 10000 documents take precedence,
followed by documents that describe Sun hardware, then the Solaris
documents.

man Pages

The man pages for functions that run on the SSP are initially located on the SSP
in /opt/SUNWssp/man . The man pages for Network Time Protocol (NTP) are
initially loaded on the SSP (and on domains) within /opt/SUNWxntp/man .
Unless noted otherwise, all man pages referenced in this document are SSP
man pages. They are included in the Ultra Enterprise 10000 SSP Reference, and
you can view them in an SSP Window via the man(1)  command.
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Overview of the SSP Tools 2

This chapter introduces:

• hostview(1M) —This is a graphical user interface (GUI) front-end to SSP
commands.

• netcontool(1M) —This is a GUI interface to the netcon(1M)  command.
netcontool(1M)  simplifies the process of configuring and bringing up
netcon(1M)  Windows. You can also use the netcon(1M)  command
directly to display a netcon(1M)  Window. However, when using
netcon(1M) , you must know escape sequences to perform operations
which can be performed by clicking on buttons under netcontool(1M) .
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Instances of Client Programs and Daemons
An Enterprise 10000 platform may host multiple domains, where each domain
runs its own copy of the operating system, independent of any other domains.
The client programs and daemons running on the SSP fall into three categories
with respect to how many instances are created relative to a platform and its
domains.

• For certain clients and daemons, exactly one instance is created on the SSP,
without regard to the platform or the number of domains that exist on the
platform. For these clients and daemons, the setting of the environment
variable SUNW_HOSTNAME is irrelevant. Here is an illustration of this type of
client or daemon.

• For some clients and daemons, one instance is started for the platform. In
the current release, where the SSP can control only a single platform, there is
little difference between this type of client or daemon and the type
described above. However, when a client or daemon is specific to a
platform, the setting of SUNW_HOSTNAME is important; SUNW_HOSTNAME
must identify the platform. This can be accomplished by setting
SUNW_HOSTNAME to the name of the platform or to the name of a domain on
the platform. Here is an illustration.

SSP Platform 1 Platform 2 Platform

Only one

SSP Platform

Domain

Domain
instance

SUNW_HOSTNAME
is irrelevant.

SSP Platform 2 Platform 3

 Instance

Instance 3

Instance 2

Platform

Domain

Domain

SUNW_HOSTNAME
must identify the
platform.
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• For certain other clients and daemons, one instance is created on the SSP for
each domain on the platform. Before you execute a client application of this
genre, set SUNW_HOSTNAME to the relevant domain name. (hpost(1M)  and
bringup(1M)  are examples of this genre.) Here is an illustration.

Hostview
Hostview enables you to perform the following actions:

• Power a platform on and off.
• Dynamically reconfigure the boards within a platform, logically attaching

or detaching them from the operating system. This feature is described in
the Dynamic Reconfiguration User’s Guide.

• Dynamically group system boards into domains. Each domain runs its
own instance of Solaris and has its own log messages file.

• Bring up domains.
• Start an SSP Window for each domain.
• Access the SSP log messages file for each platform or domain.
• Remotely log in to each domain.
• Edit the blacklist(4)  file to enable or disable hardware components on

a domain.
• Bring up a netcon(1M)  Window.

If you wish to run Hostview, you only need to run one instance for a given
platform, although it is possible to run more than one instance at a time
(perhaps on different SSPs) to work with the same platform. You can run
Hostview from any SSP Window (i.e., a session where you have logged in as
user ssp ).

SSP Platform 1 Platform 2 Platform 3

Instance 1 Domain Domain

SSP Platform

Instance 1

Instance 2

Domain

DomainSUNW_HOSTNAME
must be set to the
domain name.
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If you have logged into the SSP environment from a workstation, make sure
your DISPLAY environment variable is set to your current display and that
your xhost  settings let the SSP display on your workstation (see xhost(1)  in
Solaris X Window System Reference Manual).

♦ To start up Hostview, run the hostview(1M)  command in an SSP
Window. For example:

ssp% hostview &
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Hostview Main Window

When you start up Hostview, the main window is displayed:

Figure 2-1 Hostview — Main Window

System Board

Support Board

Temperature
Fans

Control Board

Busses

Domain 1

Selected Board

(colored border)

Failure

Power

Domain 2
(colored border)
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The menu bar on the main window provides the commands that you can use
to control the platform. See “Main Window Menu Bar” on page 2-7.

The buttons on the main window (power, temperature, and so forth) bring up
status details. The buttons are introduced in “Main Window Buttons” on
page 2-12.

The rest of the main window provides a graphical view of the platform boards
and busses. The system boards are named SB0 through SB15, and their
processor numbers are shown. The control boards are named CB0 and CB1.
The support boards are named CSB0 and CSB1. The busses are named ABUS0
through ABUS3, and DBUS0 through DBUS3.

The system boards along the top of the display are arranged in the order they
appear on the front side of the physical platform. The system boards along the
bottom of the display are arranged in the order they appear on the back side of
the physical platform.

If a system board is shown with no outline, the board is not part of a domain
and is not currently selected.

If a system board is part of a domain, a colored outline surrounds it. The
boards within a given domain all have an outline of the same color.
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A black outline (around the domain color outline) indicates that a board is
selected.

The processors within the boards are numbered 0 through 63. The processor
symbols (diamond, circle, and so forth) indicate the state of the processors, and
are described in “Main Window Processor Symbols” on page 2-14.

▼ To Select Items in the Main Window

You can select one or more boards in the main window. You can also select one
domain in the main window. You must select a domain and/or a set of boards
prior to performing certain operations, such as creating a domain.

• To select a single board, click on it with the left mouse button. The board is
then selected (as indicated by a black outline), and all other boards are
deselected.

• To select additional boards, click on the additional boards with the middle
mouse button. You can also deselect a currently selected board by clicking
on it with the middle mouse button. (The middle mouse button toggles the
selection status of the board without affecting the selection status of any
other board.)

• To select a domain, click on a board within that domain with the left mouse
button. Note that it is possible to select boards from different domains
(using the middle mouse button), but the selected domain will correspond
to the board that you selected with the left mouse button.

Main Window Menu Bar

The Hostview menu bar looks like this.

Figure 2-2 Hostview Menu Bar
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The menu items are shown in the following table.

Table 2-1 Hostview Menu Items

Menu Selection Description

File SSP Logs Displays a window that shows the SSP
messages for a domain or for the
platform. For more information, see “SSP
Log Files” on page 3-1.

Quit Terminates Hostview.

Edit Currently, this menu provides no choices.

Control Power Brings up a graphical display that
enables you to turn the power on and off
for the selected board. See “To Power
Components On or Off from Hostview”
on page 3-3. You can also set the JTAG
claim and margin/trip settings.

Bringup Brings up a detail that lets you execute
bringup(1M)  on a domain. See “To
Bring Up a Domain from Hostview” on
page 3-22.

Fan Brings up a detail that lets you execute
fan(1M)  to control the fans within the
platform. See “To Control the Fans from
Hostview” on page 3-12.

Configuration Board Enables you to attach and detach system
boards. This feature is described in the
Dynamic Reconfiguration User’s Guide.
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Domain Provides a pullright menu with several
choices. The menu choices enable you to
create domains, remove domains, rename
domains, obtain the status of domains,
and view the history of domains. A
domain consists of one or more system
boards running the same operating
system kernel. Domains function
independently of each other. Each
domain can carry its own workload and
has its own log messages file. For more
information see “To Create Domains
from Hostview” on page 3-15 and “To
Remove Domains via Hostview” on
page 3-18.

Terminal netcontool Brings up a graphical interface to the
netcon(1M)  command, enabling you to
open a network console window for a
domain. This menu item is equivalent to
executing the netcontool(1M)
command. See “netcon(1M) Window” on
page 2-15.

SSP Provides pullright menu choices that
enable you to bring up an SSP Window
in xterm, shelltool, or cmdtool format
with a platform or domain as its host.
Choose a domain (by selecting any
system board within that domain) before
choosing this option.

rlogin Provides pullright menu choices that
enable you to remotely log onto the
selected platform or domain in an xterm,
shelltool, or cmdtool window. Choose a
domain (by selecting any system board
within that domain) before choosing this
option.

Table 2-1 Hostview Menu Items

Menu Selection Description
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View All Domains Displays the boards within all domains,
as well as any boards that are not part of
a domain. (A board can be present
without being part of a domain, although
a board cannot be used when it is not
part of a domain.)

Individual
Domains

When you select an individual domain,
only the boards within that domain are
displayed. Note that the color of the
outline used to designate a given domain
is used as the background color for that
domain in the menu. The system board
numbers for the boards that belong to
each domain are shown in square
brackets.

Help topic Provides online help information on
several topics.

Table 2-1 Hostview Menu Items

Menu Selection Description
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Help Window

When you select a topic from the Help menu, the following window is
displayed.

You can select the desired topic in the upper pane. The corresponding help
information is displayed in the lower pane.
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Main Window Buttons

The main Hostview window contains the buttons described below. If an out-of-
boundary condition exists or an error has occurred, one or more of these
buttons turn red.

The power button (above) brings up the power detail which enables you to
view the power status for the platform. See “To Power Components On or Off
from Hostview” on page 3-3.

The temperature button (above) brings up the temperature detail which
enables you to view the temperature status for the boards and components
within the platform. See “To Monitor the Thermal Conditions In Hostview” on
page 3-8.

The fan button (above) brings up the fan detail which enables you to view the
status of the fans within the platform. See “To Monitor the Fans In Hostview”
on page 3-10.
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When certain error conditions occur, the failure button (above) turns red. If you
click on a red failure button, a window is displayed showing the error
condition(s) that have occurred.

The following types of error conditions are trapped by this mechanism:

• Host panic recovery in progress  – The operating system on a
domain has failed and is recovering.

• Heartbeat failure recovery in progress  – The SSP was not
receiving updated platform or domain information as expected.
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• Arbitration stop recovery in progress  – A parity error or other
fatal error has occurred, and the domain is recovering. See arbitration stop
in the “Glossary”.

• Host reboot is in progress  – The domain is being manually
rebooted.

• Power-on-bringup recovery in progress  – The platform and
domains failed due to a power outage. Power has been restored, and the
system is bringing up the domains.

Main Window Processor Symbols

In the Main Window display, the shape and background color of a processor
symbol indicate the status of that processor. For example, a diamond on a
green background indicates the processor is running the operating system.

The shape indicates what the processor is running:

◆ Operating system

● hpost(1M)

■ download_helper

▲ OBP

? Unknown program

The color of a symbol indicates the state of a processor:

green Running

maroon Exiting

yellow Prerun (the OS is currently being loaded)

blue Unknown

black Blacklisted (the processor is unavailable to run programs or
diagnostics)

red Redlisted (the processor is unavailable to run programs or
diagnostics and its state may not be changed)
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white Present but not configured; that is, the processor is unavailable, but
not blacklisted or redlisted. One example is a board that has been
Hot Swapped in but not yet attached to the operating system

Hostview Performance Considerations

Each copy of Hostview requires a significant amount—5 to 10 Mbytes—of the
available swap space in the SSP. Before running multiple copies of Hostview,
make certain the SSP has sufficient swap space available.

netcon(1M) Window

▼ To Bring Up a netcon(1M) Window via netcon(1M)

♦ Run the following commands in the SSP Window.

As shown, you must be sure that SUNW_HOSTNAME is set to the name of the
domain for which you wish to bring up a netcon(1M)  Window. For more
information about the netcon(1M)  command options, refer to netcon(1M)
man page.

▼ To Bring Up a netcon(1M) Window via netcontool(1M)

1. Bring up netcontool(1M)  in either of two following ways.
• From an SSP Window, enter the following commands.

Note that SUNW_HOSTNAME must be set to the domain for which you
wish to bring up a netcontool(1M)  Window before you run the
netcontool(1M)  command.

% setenv SUNW_HOSTNAMEdomain_name
% netcon

% setenv SUNW_HOSTNAMEdomain_name
% netcontool
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• Alternatively, from Hostview, select a board from the domain for which
you wish to bring up a netcontool(1M)  Window (by clicking on that
board with the left mouse button), and then select
Terminal ➤ netcontool .

The netcontool(1M)  Window is displayed.

2. If you wish to configure the netcon(1M)  Window before you bring it up,
choose the Configure  button. The Console Configuration window is
displayed.

a. Select the type of session in the left panel, and the type of window in
the right panel.

b. Choose Done.
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3. In the netcontool(1M)  Window, choose the Connect  button.
The netcon(1M)  Window is displayed directly beneath the
netcontool(1M) Window.
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Overview of netcontool(1M)

The netcontool(1M)  Window is shown below.

Figure 2-3 netcontool — Main Window

If you choose the Configure  button, the Console Configuration window is
displayed:

Figure 2-4 netcontool — Console Configuration Window

Read Only Session
Displays a console window where you can view output from a
domain, but cannot enter commands. This is the default session
type.

Unlocked Write (-g)
Attempts to display a netcon(1M)  Window with unlocked write
permission. If this attempt succeeds, you can enter commands into
the console window, but your write permission is taken away
whenever another user requests unlocked write, locked write, or
exclusive session permission for the same domain.
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• If another user currently has unlocked write permission, it is
changed to read only permission, and you are granted unlocked
write permission.

• If another user currently has locked write permission, you are
granted read only permission.

• If another user currently has exclusive session permission, you
are not allowed to bring up a netcon(1M)  Window.

• If you are granted unlocked write permission and another user
requests unlocked write or locked write permission, you are
notified and your permission is changed to read only. You can
attempt to reestablish unlocked write permission at any time,
subject to the same constraints as your initial attempt to gain
unlocked write permission.

Locked Write (-l)
Attempts to display a console window with locked write
permission.
• If you are granted locked write permission, no other user can

remove your write permission unless they request exclusive
session permission.

• If another user currently has locked write permission, you are
granted only read only permission.

• If another user currently has exclusive session permission, you
are not allowed to display a netcon(1M)  Window.

Exclusive Session (-f)
Displays a console window with locked write permission,
terminates all other open console sessions for this domain, and
prevents new console sessions for this domain from being started.
You can change back to multiple session mode by choosing the
Rel. Write  button to release write access, or by choosing the
Disconnect  button to terminate your console session for the
domain. You can also simply quit from the console window (using
the control menu of the window). You are not granted exclusive
session permission if any other user currently has exclusive session
permission.
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Terminal Type
Use this part of the Console Configuration window to specify the
window type as Xterm , Shell Tool (shelltool(1)) , or
Command Tool (cmdtool(1)) . The netcon(1M)  Window is
brought up in the specified type of window. The default is Xterm .

When you are satisfied with the contents of the window, you can choose Done
or Apply .

To display the netcon(1M)  Window, choose the Connect  button in the
netcontool(1M)  Window. netcon(1M)  attempts to connect to the domain
that you specified in the Console Configuration window, or to your default
domain if you did not specify a domain in that window. If an error occurs, you
are notified with a message box.

If no error occurs, the netcon(1M)  Window is displayed directly beneath the
netcontool(1M)  Window. Note that these are two separate windows,
although they can affect each other. You can view messages in the console
window and, if you have write permission, enter commands.

The Disconnect  button in the netcontool(1M)  Window disconnects the
console window from the domain and removes the console window. The
netcontool(1M)  Window is still available so that you can reconfigure for
another connect session.

The OBP/kadb  button in the netcontool(1M)  Window breaks to the
OpenBoot PROM (OBP) or kadb(1M)  programs.

The Lock Write , Unlock Write , and Excl . Write  buttons in the
netcontool(1M)  Window request the corresponding mode for the console
window.

The Rel . Write  button in the netcontool(1M)  Window releases write access
and places the console in read only mode.

The Status  button in the netcontool(1M)  Window displays information
about all open consoles that are connected to the same domain as the current
session.
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Overview of netcon(1M)

The netcon(1M)  command is similar to netcontool(1M)  except that no GUI
interface is provided, making it more functional for dial-in or other low-speed
network access. Typically, you log into the SSP machine as user ssp , and enter
the netcon(1M)  command in one of the following formats:

This action changes the window in which you execute the netcon(1M)
command into a netcon(1M)  Window for the domain specified by the
SUNW_HOSTNAME environment variable for the SSP Window. You can specify
-g  for Unlocked Write permission, -l  for Locked Write permission, and -f  to
force Exclusive Session mode.

If you execute netcon(1M)  with none of these options while all console
sessions for the domain are running in read only, unlocked write, or locked
write mode, you are granted read only permission. If you execute netcon(1M)
with none of these options when the domain has no other sessions running,
you are granted unlocked write permission. (If another user is running
exclusive session for the domain, you cannot bring up a console session.)

If you have write permission, you can enter Solaris commands. In addition,
you can enter special commands prefixed by tilde (~) to perform the functions
offered by the netcontool(1M)  Window, described in the previous section.

netcon(1M) Communications
netcon(1M)  uses two distinct paths for communicating console input/output
between the SSP and a domain: the standard network interface and the cbe
interface. Usually, when the domain is up and running, console traffic flows
over the network. If the local network becomes inoperable, all interactive
access to the domain is lost and, for example, telnet, rlogin, and netcon(1M)
sessions hang.

ssp% netcon
ssp% netcon -g
ssp% netcon -l
ssp% netcon -f
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System Administration Procedures 3

This chapter describes the Ultra Enterprise 10000 system administration
procedures. For information about standard Solaris system administration
functions, see the Solaris 2.5 System Administrator AnswerBook.

You can execute many Enterprise 10000 system administration procedures on
the SSP using Hostview and netcontool(1M) . Also see the man pages in the
Ultra Enterprise 10000 SSP Reference and SunOS Reference Manual.

SSP Log Files
When you perform procedures on an SSP, error messages for a particular
domain are logged in the files:

where domain_name is the host name of the domain for which the error
occurred.

Error messages for the platform (which are not specific to a domain) are logged
in the file:

$SSPOPT/adm/domain_name/messages

$SSPOPT/adm/messages
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▼ To View a Messages File via Hostview

1. Select the appropriate board.
• If you wish to view the messages  file for a particular domain, select that

domain in the main Hostview window (by clicking on a board from that
domain with the left mouse button).

• If you wish to view the messages  file for the platform, make sure that no
domain is selected.

2. Choose File ➤ SP Logs .
The following window is displayed.

Figure 3-1 SSP Logs Window

The Domain Name field shows the name of the domain that you selected.
The Command field shows the default command used to read the file.
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3. Edit the command in the Command field, if you wish.

4. Choose the Execute  button (or press Return).
The messages  file is displayed in the main panel of the window.

Administering Power

▼ To Power Components On or Off from Hostview

You can use Hostview to turn on all power supplies within a platform, as
follows:

1. Select a board in the main Hostview window by clicking on it with the
left mouse button.
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2. Choose Control ➤ Power . The following window is displayed.

Figure 3-2 Hostview — Power Control and Status Window

The default power(1M)  command is displayed, in this case a power on
command for system board 3.

3. Click the Execute  button (or type Return) to run the command.
The results are shown in the main panel of the window.

4. For help on the power(1M)  command, choose the Help  button.
A help window is displayed. See “Help Window” on page 2-11.

Usually, after powering on the necessary components, you execute the bring
up commands on the SSP for the domains you wish to boot. See “To Bring Up
a Domain from Hostview” on page 3-22.
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If you attempt to power off the system while any domain is actively running
the operating system, the command fails and a message is displayed in the
message panel of the window. In this case, you have two choices. You can force
a power off by using the -f  (force) option of the power(1M)  command, and
reissuing the command. Or, you can issue a shutdown(1M)  or similar
command for the active domain(s) to gracefully shut down the processors, and
then reissue the power off  command. Using shutdown(1M)  ensures that all
resources are de-allocated and users have time to log off before the power is
turned off. To use shutdown(1M) , you must be logged onto the domain as
root .

If the platform loses power due to a power outage, Hostview displays the last
state of each domain before power was lost.

▼ To Power Components On or Off via Command Line

• To power on the Enterprise 10000 platform from the command line use:

• To power on only selected power supplies, use the -s  option. See
power(1M) .

Note – The Enterprise 10000 platform does not boot any domains when
powered on; individual domains must receive bring up instructions from the
SSP. See “To Bring Up a Domain from Hostview” on page 3-22.

• To power off the entire Enterprise 10000 system, use:

The command fails and returns an appropriate error message if it finds that
any processors are still running the operating system. To force it to power them
off without first de-allocating resources and giving warning to users, use the -
f  option.

Alternatively, to shut down a platform more gracefully before powering it off,
follow these steps.

ssp% power -on -all

ssp% power -off -all
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1. Open a window for each domain.

2. Log in as root.

3. Execute a shutdown(1M)  or similar command.

4. After you have performed the above steps for each domain, reissue the
power -off -all  command.

Note – Executing the power(1M)  command with no options displays the
status of the power supplies and I/O cabinets.

See the power(1M)  man page for more information.

▼ To Power Peripherals On/Off via Command Line

♦ Use the -p  option of power(1M) .

This example powers on the peripherals attached to the power control units
2 and 3.

In place of -on , you can use -off  to turn off the power to the specified
peripherals, or -v  to determine the state of the power to the specified
peripherals. For more information, refer to power(1M) .

ssp% power -p 2 3 -on
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▼ To Monitor Power Levels in Hostview

1. Click on the power button:

The following window is displayed.

Figure 3-3 Hostview — Power Status Display

In this window, the bulk power supplies are named BP0 through BP7. The
system board power supplies are numbered 0 through 15. The support
board power supplies are named CSB0 and CSB1. The control board power
supplies are named CB0 and CB1.
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2. Click on a system board, and the power detail window for that board is
displayed.

Figure 3-4 Hostview — System Board Power Detail Window

The power detail window shows the voltage for each of the five power
supplies on the board. The power levels are indicated in volts. The bars give
a visual representation of the relative voltage levels so that you can monitor
them more easily. If a bar is green, the voltage level is within the acceptable
range. If a bar is red, the voltage level is either too low or too high. (Thus, a
red bar could be short or tall.) The bars never grow taller than the height of
the window, so voltage levels that exceed the maximum threshold are
displayed as red maximum-height bars. Similarly, bars never shrink below a
minimum height, so voltage levels below the minimum threshold are
displayed as red minimum-height bars.

The control board and support board power details are similar to the system
board power detail, described above. The only difference between the detail
for a system board and the detail for a controller or support board, is the
number of power supplies.

Administering Thermal Conditions and Fans

▼ To Monitor the Thermal Conditions In Hostview

You can use Hostview to monitor thermal conditions for power supplies,
processors, ASICs, and other sensors located on system boards, support
boards, controller boards, and the centerplane.
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1. Click on the temperature button.

The following window is displayed:

Figure 3-5 Hostview — Thermal Status Display

The centerplane, support boards, controller boards, and system boards are
shown in green if their temperatures are in the normal range, and in red
otherwise.
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2. To see the thermal detail for a component, click on it with the left mouse
button. The power detail window for a system board is shown below.

Figure 3-6 Hostview — System Board Thermal Detail

The left panel of the system board detail shows the temperatures for the five
ASICs, named A0 through A4. The middle panel shows the temperatures for
the three power supplies. The right panel shows the temperatures for the
four processors, named P0 through P3.

The temperatures are displayed in degrees Centigrade, and the values are
shown numerically and as vertical bars. The vertical bars are colored green
if the temperature is within the normal range, and red otherwise. The bars
never grow taller than the height of the window, so temperature levels
above the maximum threshold are displayed as red maximum-height bars.
Similarly, bars never shrink below a minimum height, so temperature levels
below above the minimum threshold are displayed as red minimum-height
bars.

The detail windows for control boards, support boards, and the center plane
are similar.

▼ To Monitor the Fans In Hostview

You can use Hostview to monitor fan speeds and fan failures for the 32 fans
located throughout the Enterprise 10000 platform.



System Administration Procedures 3-11

3

1. Click on the fan button.

The following window is displayed.

Figure 3-7 Hostview — Fan Status Display

The fan trays are named FT0 through FT7 on the front, and FT8 through
FT16 on the back. Each fan tray contains two fans. The color of the fan tray
symbol is green if both fans in the tray are functioning at normal speed,
amber if both fans are functioning at high speed, and red if either fan within
the fan tray has failed.
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2. To see a detail window that provides fan information, click on a fan tray
symbol with the left mouse button. A fan detail window is displayed.

Figure 3-8 Hostview — Fan Tray Display

The top circle indicates the inner fan when you open the fan tray, and the
lower circle indicates the outer fan. The color surrounding each circle in the
fan detail indicates the status of that fan. The colors can be green for normal
operation at normal speed, amber for normal operation at high speed, and
red for failure.

▼ To Control the Fans from Hostview

You can control fan power and speed from within Hostview.
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1. Choose Control ➤ Fan . The following window is displayed.

Figure 3-9 Hostview — Fan Control and Status Window

The Domain Name field shows the selected domain from the platform to
which Hostview is connected. The fan(1M)  command is shown in the
Command field without any options.

2. Add the desired set of options to the fan(1M)  command, and click the
execute  button (or type Return).

For information on the fan(1M)  command itself, choose the Help  button. A
help window is displayed. See “Help Window” on page 2-11.
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For example, if you want to set the speed of the fans on the front fan shelves to
high, enter the following command:

For more information, see fan(1M) .

fan -s fast -l front
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Domains
The SSP supports commands that let you logically group system boards into
Dynamic System Domains, or simply domains, which are able to run their own
operating system and handle their own workload. Domains may be created
and deleted without interrupting the operation of other domains. You can use
domains for many purposes. For example, you can test a new operating system
version or set up a development and testing environment in a domain. In this
way, if problems occur, the rest of your system is not affected. As another
example, you can configure several domains to support different departments,
with one domain per department. In this case, you might reconfigure the
system into one domain to run a large job over the weekend.

Domain Configuration Requirements

You can create a domain out of any group of system boards, provided the
following conditions are met:

• The boards are present and not in use in another domain

• At least one board has a network interface

• The boards have sufficient memory to support an autonomous domain

• The name given the new domain is unique and matches the hostname of
the domain to be booted

Sun Microsystems suggests that the boards which will be grouped together
into domains, have their own disk from which they can be brought up, as well
as a SCSI interface for that disk. If the created domain does not have its own
disk, you must always boot it from the network.

▼ To Create Domains from Hostview

Note – Before proceeding, see “Domain Configuration Requirements” above. If
the system configuration must be changed to meet any of these requirements,
call your service provider.

1. Select the board(s) that the domain will contain.

a. Click the left mouse button on the first board.
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b. Click the middle mouse button on any additional boards.
Note that the boards you select should not currently belong to any
domain.

2. Choose Configuration,  then Domain,  then Create .
The Create Domain window is displayed.

3. Fill in the Domain Name.
The name of the domain must be preconfigured into your system by Sun
Microsystems.
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4. If all other fields are acceptable, choose Execute .

Note that the System Boards field indicates the boards that you selected in
the main Hostview window. The default OS version and the default
platform type are shown.

If Hostview successfully executes the command, it displays the message
Command completed  in the informational panel of the window.

Note – Hostview can execute only one create  or remove  command at a time.
If you attempt to execute a second create  or remove  command before the
first has completed, your attempt fails.

▼ To Create Domains from the Command Line

Many of the instructions that follow were copied from the suninstall  section
of the Sun document SPARC: Installing Solaris Software in the Solaris 2.5 System
Administrator AnswerBook. Several of these steps have been modified to reflect
Ultra Enterprise 10000 system-specific changes to the suninstall  procedures.
For more information, see the above mentioned document.

Before proceeding, see “Domain Configuration Requirements” on page 3-15. If
the system configuration must be changed to meet any of these requirements,
call your service provider.

1. Execute domain_create(1M) in an SSP Window.

where

domain_name  is the name you wish to give to the new domain. It should
be unique among all Enterprise 10000 systems controlled by the SSP.

system_board_list  specifies the boards that are to be part of this
domain. The specified system boards must be present and not in use.
Each domain must have a network interface, SCSI interface, and

ssp# domain_create  -d domain_name -b system_board_list  \
-o os_version  -p platform_name
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sufficient memory to support an autonomous system. List the board
numbers, separated by commas or spaces, for all boards you wish to
include.

os_version  is the version of the operating system (possibly including the
patch-level) to be loaded into the domain, such as 2.5.1 .

platform_name  is the name of the platform that contains the boards
which will make up the new domain (in case the SSP controls multiple
platforms).

2. If you wish, create a new SSP Window.
Login on the SSP machine as user ssp . When prompted for the
SUNW_HOSTNAME environment variable, enter the name of the new domain

▼ To Remove Domains via Hostview

1. In the main Hostview window, select a board from the domain that you
wish to remove (by clicking on it with the left mouse button).
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2. Choose Configuration , then Domain , then Remove. A window similar to
the following window is displayed.

Figure 3-10 Hostview — Remove Domain

3. If the default domain_remove(1M)  command is satisfactory, click the
Execute  button. Otherwise, edit the command first.
For help on the domain_remove(1M)  command, click the Help  button. A
help window is displayed. See “Help Window” on page 2-11.

Note – If the system cannot remove your domain, see domain_remove(1M)
for a list of potential errors.
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▼ To Remove Domains via the Command Line

1. Execute domain_remove(1M) .
You must execute this command in an SSP Window whose environment
variable SUNW_HOSTNAME is set to the name of the domain you wish to
remove. The domain must be inactive.

2. Verify that the command was successful.
Upon successful completion, the SSP file system for this domain is removed.

Note – If the system cannot remove your domain, it tells you why. See
domain_remove(1M)  for a list of potential errors.

▼ To Rename Domains via Hostview

1. In the main Hostview window, select a board from the domain that you
wish to rename by clicking on it with the left mouse button.

ssp% domain_remove -d domain_name
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2. Choose Configuration , then Domain , then Rename. A window similar to
the following window is displayed.

Figure 3-11 Hostview — Rename Domain Window

3. If the default domain_rename(1M)  command is satisfactory, click the
Execute  button. Otherwise, edit the command first.
For help on the domain_rename(1M)  command, click the Help  button. A
help window is displayed. See “Help Window” on page 2-11.
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▼ To Rename Domains via the Command Line

♦ Use the domain_rename(1M)  command.

For more information, see the domain_rename(1M) , domain_remove(1M) ,
and domain_create(1M)  commands.

▼ To Bring Up a Domain from Hostview

1. Select the domain you wish to bring up.
Use the mouse to select any system board belonging to the domain you wish
to bring up.

2. Choose Bringup ➤ Control .
A window that shows the name of the selected domain is displayed.

3. Choose Execute  to perform the bring up.

4. After the bring operation up has completed, choose Terminal ➤

netcontool .
This command changes the SSP Window to a netcon(1M)  window and
displays the OBP prompt.

5. Type boot  at the OBP prompt.

The domain should boot and then display the login prompt. Note that you
can use the OBP command devalias  to determine the alias for the disk
you wish to use as the boot_device.

▼ To Bring Up a Domain from the Command Line

Before you can bring up a domain from the command line in an SSP Window,
the power supplies for the domain must be powered on.

% domain_rename -d old_host_name -n new_host_name

OK boot boot_device
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1. Set the SSP to control the proper domain.
The SSP controls the domain specified by the SUNW_HOSTNAME environment
variable. To check its value, enter:

If SUNW_HOSTNAME is set to a domain other than the one you wish to bring
up, change it:

2. Power on the power supplies for all boards in the domain (specified by
SUNW_HOSTNAME).

3. Bring up the domain by executing the following commands:

▼ To Obtain Domain Status via Hostview

1. In the main Hostview window, select a board from the domain for which
you wish to obtain status information.
If the boards from the desired domain are not displayed, use the View  menu
to display the desired domain (or all domains).

ssp% env

ssp% setenv SUNW_HOSTNAMEdomain_name

ssp% power -on

ssp% bringup -A [off/on] [ disk]
ssp% netcon
ok boot
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2. Choose Configuration , then Domain , then Status . A window similar to
the following window is displayed.

Figure 3-12 Hostview — Domain Status Window

3. Click the Execute  button, and the status listing is displayed in the main
panel of the window.
The status listing has five columns:

• DOMAIN is the name of the domain.
• TYPE is the platform type. It can be either UE10000 or CS6400.
• PLATFORM is the name of the platform. (The platform name is set after the

SSP packages are installed.)
• OS is the operating system identification number.
• SYSBDS indicates the system boards that make up the domain.
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▼ To Specify the Domain for an SSP Window

1. Open a new SSP Window.

2. When you are prompted to provide a value for the environment variable
SUNW_HOSTNAME, specify the name of the domain that you wish to control
and monitor from within that SSP window.

▼ To Create a netcon(1M) Window for a Domain

♦ Execute netcontool(1M)  or netcon(1M)  in an SSP Window that has its
SUNW_HOSTNAME set to the domain name.

SSP Messages Files

Each domain has its own SSP messages file, named
${SUNW_SSPVAR}/adm/{$SUNW_HOSTNAME}/messages, where
$SUNW_HOSTNAME is the name of the domain.

Blacklisting Components
You can use the blacklisting feature to configure out any of the following
components:

• System boards
• Processors
• Address busses
• Data busses
• Data Routers
• I/O controllers
• I/O adapter card
• System board memory
• Memory DIMM groups
• Enterprise 10000 half-centerplane
• Port controller ASICs
• Data buffer ASICs
• Coherent interface controller ASICs
• 72-bit half of 144-bit local data router within system boards
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Generally, you may want to blacklist a component if you believe that
component is having intermittent problems, or if it is failing sometime after the
system is booted.

If a component has a problem that shows up in hpost(1M)  (which is run by
the bringup(1M)  command), that component is automatically configured out
of the system by hpost(1M) . However, that component is not blacklisted.
hpost(1M)  is run on all components in the system before the domain is
booted, and on all components on a given board before that board is attached
via Dynamic Reconfiguration (DR). See the Dynamic Reconfiguration User’s
Guide.

To blacklist a component, edit the blacklist(4)  file with a text editor. When
a domain runs POST, hpost(1M)  reads the blacklist(4)  file and
automatically configures out the components specified in that file. Thus,
changes that you make to the blacklist(4)  file do not take effect until the
machine is rebooted.

The file is SSPVAR/etc/ platform_name/blacklist , where platform_name is
the name of the platform. See the blacklist(4)  man page for information
about the contents of the blacklist(4)  file.
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▼ To Blacklist Boards and Busses via Hostview

1. In Hostview, select Edit ➤ Blacklist File .
The Blacklist Edit window is displayed.

2. Select the boards and/or busses that you wish to blacklist.
To select a single component and de-select all other components of that type
(e.g., to select a single board and de-select all other boards), click on that
component with the left mouse button. To toggle the selection status of a
single component without affecting the selection status of any other
component, click on that component with the middle mouse button. The
selected components are displayed in black.

3. To save the changes, select File ➤ Save .
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4. To exit the Blacklist Edit window, select File ➤ Close .
If you have unsaved changes and you close the Blacklist Edit window by
selecting the File  menu and choosing Close , you are asked if you wish to
save the changes.

▼ To Blacklist Processors via Hostview

1. Select Edit ➤ Blacklist File .
The Blacklist Edit window is displayed.

2. From the Blacklist Edit window, select View ➤ Processors .
The Blacklist Edit window displays the processor view.
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3. Select the processors that you wish to blacklist.
To select a single processor on a board and de-select all other processors on
that board, click on that processor with the left mouse button. To toggle the
selection status of a processor on a board without affecting the selection
status of any other processors on that board, click on that processor with the
middle mouse button. The selected processors are displayed in black.

4. To save the changes, select File ➤ Save .

5. To exit the Blacklist Edit window, select File ➤ Close .
If you have unsaved changes and you close the Blacklist Edit window by
selecting the File  menu and choosing Close , you are asked if you wish to
save the changes.

▼ To Clear the Blacklist File via Hostview

1. In Hostview, select Edit ➤ Blacklist File .
The Blacklist Edit window is displayed.

2. From the Blacklist Edit window, select File ➤ New.

3. From the Blacklist Edit window, select File ➤ Close .

Dual Control Board Handling
A platform can be configured with dual control boards for redundancy
purposes. Although you can manually switch between the control boards, only
one control board at a time is used by the system. This section covers various
issues concerning dual control boards:

• Configuring dual control boards
• Control board executive
• Control board server
• Changing control boards

One of the control boards is identified as the primary control board. The SSP
will attempt to communicate only with the primary control board. If the
system administrator decides that it is necessary to switch the primary control
board because of a connection failure or for other reasons, the system
administrator must modify the control board configuration file and reboot the



3-30 Ultra Enterprise 10000 SSP User’s Guide—March 1997

3

SSP to activate the new primary control board. Note that this operation cannot
be performed without rebooting all running domains, because the control
board is providing system clocks for all boards.

Control Board Executive (cbe)

Booting

When power is applied, both control boards boot from the SSP serving as the
boot server. Once cbe  is booted, it waits indefinitely for cbs(1M)  connection.

Master Control Board

When cbs(1M)  connects to cbe  running on a control board, cbe  asserts the
control board as the master control board. The master control board is
responsible for providing system clock and JTAG clock, and controlling fan
trays and bulk power supplies.

Control Board Server (cbs)

After the SSP is booted, cbs(1M)  is started automatically. cbs(1M)  is
responsible for all communication between the SSP and the primary control
board.

Connection

cbs(1M)  attempts to connect only to the primary control board identified in
the control board configuration file. The format of the file is as follows:

where:

platform_name is the name assigned by the system administrator

platform_type is defaulted to UE10000

cb0 is control board 0 host name, if available

platform_name: platform_type: cb0: status0: cb1: status1
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status0 indicates if control board 0 is the primary, if available. P indicates
primary and anything else indicates non-primary.

cb1 is control board 1 host name, if available

status1 indicates if control board 1 is the primary, if available

For example:

This example indicates that there are two control boards in the xf2  platform.
They are xf2-cb0  and xf2-cb1 . xf2-cb0  is specified as the primary. See the
cb_config(4)  man page for more information.

The communication port that is used for cbs(1M) /cbe  communication is
specified in /tftpboot/XXXXXXXX.cb_port  where XXXXXXXX is the control
board IP address represented in hex format.

Control Board Executive Image and Port Specification Files

The SSP is the boot server for the control board. Two files are downloaded by
the control board boot PROM during boot time: the image of cbe  and the port
number specification file. These files are located in /tftpboot  in the SSP and
the naming conventions are:

where XXXXXXXX is the control board IP address in hex format.

For example, the files for control board xf2-cb0  are:

xf2:UE10000:xf2-cb0:P:xf2-cb1:

/tftpboot/XXXXXXXX for the cbe  image
/tftpboot/XXXXXXXX.cb_port for the port number

/tftpboot/81993193
/tftpboot/81993193.cb_port
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The IP address of xf2-cb0  can be determined by:

The returning address is: 129.153.49.147 which can be converted to 81993193.

Changing Control Boards — Hardware Procedures

▼ To Swap the Non-Primary Control Board

1. Use the power(1M)  command to power off the control board.

2. Remove the control board that has its unsafe-to-swap LEDs off.

3. Install the new control board.

The control board will power itself on. There is no need to run the
power(1M)  command.

4. Make the appropriate change on the SSP side, which includes updating
the ether file with the new control board's Ethernet ID. The suggested
procedure is to retain the same hostname and IP address, and change only
the ether file.

▼ To Swap the Primary Control Board

It is not possible to power off the primary control board, and the system cannot
function without a control board. Therefore, you must shut down all domains
before proceeding.

1. Shut down all domains.

2. Use the power(1M)  command to power off the centerplane support board
that resides on the same slot.

3. Turn off the breaker for the slot.

4. Remove the control board.

5. Install the new control board.

6. Turn on the breaker.

% ypcat hosts | grep xf2-cb0
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7. Make the appropriate change on the SSP side, which includes updating
the ether file with the new control board's Ethernet ID. Reboot the SSP.

8. Power on the centerplane support board.

Changing Control Boards — Software Procedures

▼ To Add A New Control Board

1. Determine the slot position, hostname and IP address of the new control
board.

2. Modify $SSPOPT/.ssp_private/cb_config  to add the new hostname
and status accordingly. See cb_config(4)  man page for more
information.

▼ To Change the Control Board Hostname and IP Address

Assuming dual control boards are specified, you can change the hostname
and/or IP address of the non-primary control board as follows.

1. If you are changing the control board hostname, modify
$SSPOPT/.ssp_private/cb_config  to the new control board host name.

2. If you are changing the IP address of the control board, rename
/tftpboot/ XXXXXXXX to /tftpboot/ YYYYYYYY and
/tftpboot/ XXXXXXXX.cb_port  to /tftpboot/ YYYYYYYY.cb_port
where XXXXXXXX is the IP address of the previous control board
hostname, and YYYYYYYY is the IP address of the new control board
hostname:

To change the hostname and/or IP address of the primary control board:

1. Repeat steps 1 and/or 2, above, as necessary.

2. Reboot the SSP.

% mv /tftpboot/ XXXXXXXX /tftpboot/ YYYYYYYY
% mv /tftpboot/ XXXXXXXX.cb_port  /tftpboot/ YYYYYYYY.cb_port
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▼ To Switch the Primary Control Board

Assuming dual control boards are specified, you can switch the primary
control boards as follows:

1. Modify $SSPOPT/.ssp_private/cb_config  so that either cb_status0
or cb_status1  field is set to P to indicate primary control board.

2. Reboot the SSP.
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SSP Internals 4

SSP operations are generally performed by a set of daemons and commands.
This section provides a general overview of how the SSP works, and describes
the SSP daemons, processes, commands, and system files. For more
information about daemons, commands, and system files, refer to the Ultra
Enterprise 10000 SSP Reference.

Start Up Flow
The sequence of events that take place when the SSP boots and starts the
Enterprise 10000 system are illustrated in Figure 4-1, below.

Warning – Changes made to files in /opt/SUNWssp  can cause a system crash
and serious damage to the system. Only very experienced system
administrators should risk changing the files described in this chapter.!
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SSP Boot Process

/sbin/init

init  loads /etc/inittab

inittab  includes a command to start ssp_startup

1. Power on the SSP
(Monitor, CPU/disk, and CDROM)
The SSP boots automatically

Daemon Start Up

ssp_startup  starts up the platform daemons: edd
and snmp. It then starts up the non-domain daemons in
the proper order (although the order of startup is not
specified here): cbs , machine_server , fad , straps ,
and xntpd . ssp_startup  also sets up environment
variables.

edd
edd  uploads event detection scripts to the Enterprise
10000 control board, waits for an event to be generated
by the event detection scripts running on the control
board, and then responds to the event by executing a
response action script on the SSP.
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Figure 4-1 Start Up Flow

The SSP monitors and controls the Enterprise 10000 system using edd(1M)
(the event detector daemon). Each time the SSP boots, it runs init(1M)  which
in turn loads edd(1M)  via the start up script, $SSPETC/ssp_startup.sh . The
start up script checks the environment for availability of certain files and

2. domain_create
Run domain_create . You only need to do this once
for each domain.

3. Apply power to platform or domain
Set SUNW_HOSTNAME to the domain name.

4. bringup

bringup checks host for operating system running,
runs POST, then runs obp_helper , which runs OBP,
and starts netcon_server(1M) .

The system loads the operating system
and the boot process is complete
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availability of the Enterprise 10000 itself, sets environment variables, and then
starts edd(1M) . edd(1M)  obtains many of its initial control parameters from
the following configuration files:

• $SSPVAR/etc/ platform_name/edd.erc  provides configuration information
for the Enterprise 10000 platform, itself.

• $SSPVAR/etc/ platform_name/ domain_name/edd.erc  provides
configuration information for a particular domain. The event response
configuration files (edd.erc ) specify how the event detector will respond to
events.

• $SSPVAR/etc/ platform_name/edd.emc  lists the events that edd(1M)  will
monitor.

If a domain crashes, edd(1M)  invokes the bringup(1M)  script. The
bringup(1M)  script runs the Power-On Self-Test (POST) program, which tests
Enterprise 10000 components. It then uses the obp_helper(1M)  daemon to
download and begin execution of OpenBoot PROM (OBP) in the domain
specified by SUNW_HOSTNAME. This only happens if a domain goes down (for
example, after a kernel panic) in which case it is rebooted automatically. After
a manual power on, or after a halt or shut down, you must manually run
bringup(1M) , which then causes OBP to be downloaded and executed.

obp_helper(1M)  is responsible for loading download_helper  in all the
configured processors’ bootbus SRAM. All the processors are started, with one
processor designated the boot processor. With the assistance of
download_helper , obp_helper(1M)  loads OBP into the memory of the
Enterprise 10000 system and starts OBP on the boot processor. See
“obp_helper” on page 4-12 for more information about obp_helper(1M)  and
OBP.

The primary task of OBP is to boot and configure the operating system from
either a mass storage device or from a network. OBP also provides extensive
features for testing hardware and software interactively. As part of the boot
procedure, OBP probes all the SBus slots on all the system boards and builds a
device tree. This device tree is passed on to the operating system.



SSP Internals 4-5

4

Enterprise 10000 Client/Server Architecture
The Enterprise 10000 control board interface is accessed over an Ethernet
connection using the TCP/IP protocol. The control board executive, cbe , runs
on the control board and the control board server, cbs(1M) , on the SSP makes
service requests. The SSP control board server (the client to the real cbs(1M) )
is a server to other SSP clients.

The following diagram illustrates the Ultra Enterprise 10000 system
client/server architecture:

Figure 4-2 Enterprise 10000 Client/Server Architecture
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Note – There is one instance of edd(1M)  for each platform supported by the
SSP. Also, there is one instance of obp_helper(1M)  and
netcon_server(1M)  per domain.

POST
POST (Power-On Self-Test) probes and tests the components of uninitialized
Enterprise 10000 system hardware, configures what it deems worthwhile into a
coherent initialized system, and hands it off to OBP. POST passes along to OBP
a list of only those components that have been successfully tested; those in the
blacklist(4)  are excluded.

hpost(1M)  is the SSP-resident executable program that controls and
sequences the operations of POST. hpost(1M)  reads directives in the optional
file .postrc  (see postrc(4) ) before it begins operation with the host.

POST looks at blacklist(4)  which is on the SSP, before preparing the
system for booting. blacklist(4)  specifies the Enterprise 10000 components
that POST must not configure.

POST stores the results of its tests in an internal data structure called a board
descriptor array. The board descriptor array contains status information for
most of the major components of the Enterprise 10000 system, including
information about the UltraSPARC modules.

POST attempts to connect and disconnect each system board, one at a time, to
the system centerplane. POST then connects all the system boards that passed
to the system centerplane.

Warning – Running hpost(1M)  outside of the bringup(1M)  command can
cause the system to crash. hpost(1M) , when run by itself, does not check the
state of the platform, and causes fatal resets.!
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Daemons
The SSP daemons play a central role in its operation. Each daemon is fully
described in its corresponding manual page. The daemons are:

cbs The control board server provides central access to the
Enterprise 10000 control board for client programs running on
the SSP.

edd The event detector daemon uploads event detection scripts to
control boards. When one of these scripts detects an event,
edd(1M)  executes a response action script.

fad The file access daemon provides distributed file access services
to SSP clients that need to monitor, read, and write to the SSP
configuration files.

machine_server Provides machine services for netcon(1M)  and routes host
messages to proper messages file. See
machine_server(1M) .

netcon_server The connection point for all netcon(1M)  clients.
netcon_server(1M)  communicates with OBP via a control
board protocol and the OS via a TCP protocol.

obp_helper Begins execution of OpenBoot. obp_helper(1M)  terminates
when OBP does. During execution, obp_helper(1M)  provides
services to OBP, such as nvram simulation, idprom simulation,
and time of day. The netcon_server(1M)  is part of
obp_helper(1M) .

snmpd The SNMP proxy agent listens to a UDP port for incoming
requests, and services the group of objects specified in
Ultra-Enterprise-10000.mib .

straps The SNMP trap sink server listens to the SNMP trap port for
incoming trap messages and forwards received messages to all
connected clients.

xntpd The network time protocol (NTP) daemon provides time
synchronization services. Clients can connect to this service
and have their clocks automatically adjusted. This service is
used to synchronize SSP and domain times. See xntpd(1M)
and the Network Time Protocol User’s Guide.
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Event Detector Daemon (edd )

The event detector daemon, edd(1M) , is a key component in providing the
reliability, availability, and serviceability (RAS) features of Enterprise 10000.
edd(1M)  uploads event detection scripts to the Enterprise 10000 control board,
waits for an event to be generated by the event detection scripts running on the
control board, and then responds to the event by executing a response action
script on the SSP. The conditions that generate events and the response taken to
events are fully configurable.

The edd(1M)  provides the mechanism for event management, but it doesn’t
handle the events directly. Event handling is provided by response action
scripts, which are invoked by the edd(1M)  when an event is received.

The RAS features are provided by several collaborative programs. The control
board within the platform runs a control board executive (cbe) program that
communicates via Ethernet with a control board server (cbs(1M) ) program on
the SSP. These two components provide the data link between the platform and
the SSP.

The SSP provides a set of interfaces for accessing the control board via the cbs
and the simple network management protocol (SNMP) agent. The edd(1M)
utilizes the CBS interface to upload event detection scripts to the cbe. This is
illustrated below:

Figure 4-3 Uploading Event Detection Scripts

Once uploaded, event detection scripts poll various conditions within the
platform, including environmental conditions, signature blocks, power supply
voltages, performance data, and so forth. If an event detection script detects a
change of state that warrants an event, an event message containing the
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pertinent information is generated and delivered to the cbs(1M)  running on
the SSP. Upon receipt of the event message, the cbs(1M)  delivers the event to
the SNMP Agent, which in turn generates a SNMP trap, as shown below:

Figure 4-4 Event Recognition and Delivery

Upon receipt of an SNMP trap, the edd(1M)  determines whether or not to
initiate a response action. If a response action is required, the edd(1M)  runs
the appropriate response action script as a subprocess. This is illustrated
below:

Figure 4-5 Response Action
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For instance, in Figure 4-5 edd(1M)  is running a response action script for a
high temperature event. While the response action script is running, additional
high temperature events may be generated by the event monitoring scripts.
edd(1M)  does not respond to those high temperature events (generated in
response to the same high temperature condition) until the first response script
has finish. It is the responsibility of applications (such as edd(1M) ) to filter the
events they will respond to as necessary.

The cycle of event processing is completed at this point.

Control Board Server (cbs )

cbs(1M)  is a server that runs on the SSP. Whenever a client program running
on the SSP needs to access the Enterprise 10000, the communication is funneled
through cbs(1M) . cbs(1M) , in turn, communicates directly with a control
board executive (cbe ) running on one of the control boards in the Ultra
Enterprise 10000 system. cbs(1M)  converts client requests to the control board
management protocol (CBMP) which is understood by cbe . The following
diagram illustrates how this communication takes place:

Figure 4-6 SSP / Enterprise 10000 Communication Through cbs(1M)
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File Access Daemon (fad )

The file access daemon (fad(1M) ) is used when ssp_to_domain_hosts(4)
or any other configuration file is updated. fad(1M)  provides distributed file
access services, such as file locking, to all SSP clients that need to monitor,
read, and write changes to SSP configuration files. Once a file is locked by a
client, other clients are prevented from locking that file until the first client
releases the lock.

Network Time Protocol Daemon (xntpd )

xntpd(1M)  provides a mechanism for keeping the time settings synchronized
between the SSP, the platform, and the domains. Each domain obtains the time
from the SSP at boot time. If the time settings were allowed to vary between
the platform and the SSP, an anomalous error condition would occur.

The configuration is based on information provided by the system
administrator. If you are not currently running NTP at your site and you do
not have access to the Internet and you are not going to use a radio clock, you
can set up the Enterprise 10000 system to use its own internal reference clock
as the reference clock.

The Solaris 2.5 NTP packages are compiled with support for a local reference
clock. This means that your system can poll itself for the time instead of
polling another system or network clock. The poll is done through the network
loopback interface. The first three numbers in the IP address are 127.127.1. The
last numbers in the IP address are the NTP stratum to use for the clock.

When setting up an Ultra Enterprise 10000 system and its SSP, the SSP should
usually be set to stratum 4. The Enterprise 10000 system should be set up as a
peer to the SSP and set its local clock two stratums higher.

An example of server/peer lines in the /etc/opt/SUNWxntp/ntp.conf  file
on the SSP is shown below.

server 127.127.1.4



4-12 Ultra Enterprise 10000 SSP User’s Guide—March 1997

4

An example of server/peer lines in the /etc/opt/SUNWxntp/ntp.conf  file
on the platform is shown below.

This tells the SSP to pretend its clock is stratum 4 so the SSP runs at stratum 5.
The Enterprise 10000 system considers its own time to be stratum 6. While the
SSP is up, the Enterprise 10000 system favors the SSP’s time at stratum 5, and
so it runs at stratum 6. If, for some reason, the SSP goes down, the Enterprise
10000 system uses its own clock and runs at stratum 7.

For more information on xntpd(1M) , refer to the Network Time Protocol User’s
Guide and the NTP Reference.

obp_helper

Note – OpenBoot PROM (OBP) is not a hardware PROM; it is actually loaded
from a file on the SSP. An SSP file also replaces the traditional OBP NVRAM
and idprom (hostid).

The OBP file is located in:

/opt/SUNWssp/release/Ultra-Enterprise-10000/2/5/1/hostobjs/obp

The “/2/5/1 ” portion of this path is specific to the version of the operating
system in your release, in this case Solaris 2.5.1. If your release contains a
different version of the operating system, that portion of the path will be
different.

Note – The OBP file is required for successful system operation. Sun
Microsystems strongly suggests that you back up this file so you have an extra
copy in case of a catastrophic SSP disk failure.

bringup(1M)  starts obp_helper(1M)  in the background, which kills the
previous obp_helper(1M) , if one exists. obp_helper(1M)  executes
download_helper  and subsequently downloads and executes OBP.

peer my_ue10000-ssp
server 127.127.1.6
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obp_helper(1M)  is essential in starting processors other than the boot
processor. It communicates with OBP through BootBus SRAM, responding to
requests to supply the time-of-day, get or put the contents of the pseudo-
EEPROM, and release slave processors when in multiprocessor mode. To
release the slave processors, obp_helper(1M)  must load download_helper
into the bootbus SRAM of all the slave processors, place an indication in
bootbus SRAM that it is a slave processor, then start the processor by releasing
bootbus controller reset.

For more information, see the obp_helper(1M) , and bringup(1M)  man
pages and “download_helper” on page 4-14.

Environment Variables
Most of the necessary environment variables are set when the
$SSPETC/ssp_env.sh  is called. The following list describes the environment
variables.

Executable Files Within a Domain
These files reside in /opt/SUNWssp/release/Ultra-Enterprise-
10000/ os_version and are executed within a domain. The man pages for these
programs reside within the domain.

Table 4-1 Environment Variables

SUNW_HOSTNAME The name of the domain controlled by the SSP.

SSPETC The path to the directory containing
miscellaneous SSP-related files.

SSPLOGGER You should never change the value of this
environment variable. It specifies the location of
the configuration file for message logging.

SSPOPT The path to the SSP package binaries, libraries,
and object files.

SSPVAR The path to the directory where modifiable files
reside.
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Some of the commands listed in this section should be used or modified only
by your service provider; they are normally called internally by other
programs rather than executed on the command line.

Caution – Improper use of these commands may result in failure or damage to
the system. If you are not sure of the function of any command, contact your
service provider for assistance.

*.elf

These are executable files that are downloaded by hpost(1M) .

download_helper

download_helper  allows programs to be downloaded to the memory used
by a domain instead of BBSRAM. This provides an environment in which host
programs can execute without having to know how to relocate themselves to
memory. These programs can be larger than BBSRAM.

download_helper  works by executing a protocol through a mailbox in
BBSRAM. The protocol has commands for allocating and mapping physical to
virtual memory, and for moving data from a buffer in BBSRAM to virtual
memory, and vice-versa. Once complete, the thread of execution is usually
passed to the new program at an entry point provided by the SSP. After this
occurs, download_helper  lives on in BBSRAM so it can provide reset-
handling services. Normally, a user would not be concerned with the
download helper; it should be used only by obp_helper(1M) . See the
obp_helper(1M)  man page for more information.

obp

The file obp  is named after OpenBoot PROM. obp  is fundamental to the boot
process of a domain. It knows how to probe the SBUS to determine which
devices are connected where, and provides this information to the operating
system in the form of a device tree. The device tree is ultimately visible using
the Solaris command prtconf  (for more information, see the SunOS
prtconf(1M)  man page).
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obp  also interprets and executes FCode on SBus cards, which provides
loadable, simple drivers for accomplishing boot. In addition, it provides a
kernel debugger, which is always loaded.
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Glossary A

ASIC
Application-specific integrated circuit. Used in the Enterprise 10000 system
context to mean any of the large main chips in the design, including the
UltraSPARCTM processor and data buffer chips.

arbitration stop
A condition that occurs when one of the Ultra Enterprise 10000 ASICs detects a
parity error or equivalent fatal system error. Bus arbitration is frozen, so all bus
activity stops. The system is dead until the SSP detects the condition by polling
the CSRs of the Address Arbiter ASICs via JTAG, and clears the error
condition.

BBSRAM
See bootbus SRAM.

blacklist
A text file that hpost(1M)  reads when it starts up that tells it about Enterprise
10000 system components that are not to be used or configured into the system.
The default path name for this file can be overridden in the .postrc  file (see
postrc(4) ) and on the command line.

board descriptor array
The description of the single configuration that hpost(1M)  chooses. It is part
of the structure handed off to OBP.
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bootbus
A slow-speed byte-wide bus controlled by the processor port controller ASICs,
used for running diagnostics and boot code. UltraSPARC starts executing code
from BootBus when it exits reset. In Enterprise 10000 system, the only
component on the BootBus is the BBSRAM.

bootbus SRAM
A 256 Kbyte static RAM attached to each processor PC ASIC. Through the PC,
it can be accessed for read/write from JTAG or the processor. It is downloaded
at various times with hpost(1M)  and OBP start-up code, and provides shared
data between the downloaded code and the SSP.

CSR
Control and Status Register. A general term for any embedded register in any
of the ASICS in the Enterprise 10000 system.

DIMM
Dual in-line Memory Module, a small printed circuit card containing memory
chips and some support logic.

domain
A set of one or more system boards that act as a separate system capable of
booting the OS and running independently of any other domains.

DRAM
Dynamic RAM. Hardware memory chips that require periodic rewriting to
retain their contents. This process is called refresh. In Enterprise 10000 system,
DRAM is used only on main memory SIMMs, and on the control boards.

ECache
External Cache. A 1/2 MByte to 4 MByte synchronous static RAM second-level
cache local to each processor module. Used for both code and data. This is a
direct-mapped cache.

JTAG
A serial scan interface specified by IEEE standard 1149.1. The name comes from
Joint Test Action Group, which initially designed it. See JTAG+.

JTAG+
An extension of JTAG, developed by Sun Microsystems Inc., which adds a
control line to signal that board and ring addresses are being shifted on the
serial data line. Often referred to simply as JTAG.



Glossary A-3

A

OBP
OpenBoot PROM. A layer of software that takes control of the configured
Enterprise 10000 system from hpost(1M) , builds some data structures in
memory, and boots the operating system.

POST
Power-On Self-Test, performed by hpost(1M) . This the program that takes
uninitialized Enterprise 10000 system hardware and probes and tests its
components, configures what seems worthwhile into a coherent initialized
system, and hands it off to OBP.

.postrc
A text file that controls options in hpost(1M) . Some of the functions can also
be controlled from the command line. Arguments on the command line take
precedence over lines in the .postrc  file, which takes precedence over built-in
defaults. hpost -?postrc  gives a terse reminder of the .postrc  options and
syntax. See postrc(4) .

SBus
A Sun Microsystems Inc. designed I/O bus, now an open standard.

SRAM
Static RAM. These are memory chips that retain their contents as long as
power is maintained.

SSP
System Service Processor, a workstation containing software for controlling
power sequencing, diagnostics, and booting of a Enterprise 10000 system.

UltraSPARC
The UltraSPARC processor, which is the processor module used in the
Enterprise 10000 system.
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blacklist

blacklisting components, 3-25
bringup

manual, 3-22
bringup command, 4-12
bringup host, command line, 3-22
buttons

failure, 2-13
fans, 2-12
power, 2-12
temperature, 2-12

C
cbe (control board executive), 3-30
cbs (control board server), 3-30, 4-10
colors in Hostview, 2-14
command line, creating domains, 3-17
command line, removing domains, 3-20
commands

bringup, 4-12
download_helper, 4-14
obp, 4-14

configuration menu, 2-8
board, 2-8
domain, 2-9

configuration requirements, domain, 3-15
configuring NTP, 4-11
console configuration, netcontool(1M), 2-

18
console menu, 2-9
control board executive (cbe), 3-30
control board handling, 3-29
control board server (cbs), 3-30, 4-10
control board swapping, 3-32
control menu, 2-8

bringup, 2-8
fan, 2-8
power, 2-8

controlling fans, Hostview, 3-12
creating domains, command line, 3-17
creating domains, Hostview, 3-15

D
daemons

edd, 4-8
obp_helper, 4-7, 4-12
SSP, 4-7
xntpd, 4-7

documentation, 1-9
man pages, 1-9

domain_create, 3-17
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domain_remove, 3-20
domain_rename(1M), 3-22
domains

configuration requirements, 3-15
creating domains, Hostview, 3-15
netcon(1M) window, 3-25
removing domains, Hostview, 3-18
renaming domains, Hostview, 3-20
SSP Control, 3-25
status of domains, Hostview, 3-23

download_helper command, 4-14
dual control board handling, 3-29

E
edd daemon, 4-8
edit menu, 2-8
elf files, 4-14
environment variables, 4-13

SSPETC, 4-13
SSPLOGGER, 4-13
SSPOPT, 4-13
SSPVAR, 4-13
SUNW_HOSTNAME, 4-13

error message files, 3-1
event detector daemon (edd), 4-8
exclusive session (netcon), 2-19

F
failure button, 2-13
fan speed, 3-14
fan tray display, 3-12
fans button, 2-12
fans, controlling in Hostview, 3-12
fans, monitoring in Hostview, 3-10
features

SSP, 1-1
features of SSP, 1-1
file menu, 2-8

quit, 2-8
files

error messages, 3-1

H
help menu, 2-10
Hostview, 2-3

bringup, manual, 3-22
colors, meaning of, 2-14
controlling fans, 3-12
domains, creating, 3-15
domains, removing, 3-18
domains, renaming, 3-20
domains, status, 3-23
icons, meaning of, 2-14
main window, 2-5
menu

configuration, 2-8
board, 2-8

domain, 2-9
console, 2-9
control, 2-8

bringup, 2-8

fan, 2-8

power, 2-8
edit, 2-8
file, 2-8

quit, 2-8
help, 2-10
terminal

netcontool, 2-9

rlogin, 2-9

SSP, 2-9
view

all domains, 2-10

individual domains, 2-10
menu bar, 2-7
monitoring fans, 3-10
monitoring power, 3-7
monitoring temperature, 3-8
performance considerations, 2-15
starting Hostview, 2-3
symbols, meaning of, 2-14
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icons, Hostview, 2-14

L
locked write (netcon), 2-19

M
man pages, 1-9
manual bringup, 3-22
menu

configuration, 2-8
board, 2-8
domain, 2-9

console, 2-9
control, 2-8

bringup, 2-8
fan, 2-8
power, 2-8

edit, 2-8
file, 2-8

quit, 2-8
help, 2-10
terminal

netcontool, 2-9
rlogin, 2-9
SSP, 2-9

view
all domains, 2-10
individual domains, 2-10

menu bar
Hostview, 2-7

messages files, 3-1
monitoring fans, Hostview, 3-10
monitoring power, Hostview, 3-7
monitoring temperature, Hostview, 3-8

N
netcon, 2-21
netcon(1M), 1-6
netcontool(1M), 2-18
Network Console Window, 1-6

NTP
configuring, 4-11

O
obp command, 4-14
OBP. See OpenBootProm
obp_helper daemon, 4-7, 4-12
OpenBootProm, 4-4, 4-12, 4-14

P
POST, 4-6
power

monitoring power, Hostview, 3-7
power command, 3-5

power button, 2-12
Power-On-Self-Test. See POST

R
read only session (netcon), 2-18
removing domains, command line, 3-20
removing domains, Hostview, 3-18
renaming domains, Hostview, 3-20

S
snmp agaent, 4-8
Solaris

version, 1-1
speed of fans, controlling, 3-14
SSP

Controlling a domain, 3-25
user environment, 1-4

SSP Console Window, 1-5
SSP daemons, 4-7
SSP features, 1-1
ssp log, 2-8
SSP log file, 3-1
SSP Window, 1-4
SSP window, 1-4
SSPETC, 4-13
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SSPLOGGER, 4-13
SSPOPT, 4-13
SSPVAR, 4-13
startup flow, 4-1
status of domains, Hostview, 3-23
SUNW_HOSTNAME, 4-13
swapping control boards, 3-32
symbols in Hostview, 2-14
System Service Processor, 1-1

T
temperature

monitoring termperature,
Hostview, 3-8

temperature button, 2-12
terminal menu

netcontool, 2-9
rlogin, 2-9
SSP, 2-9

terminal type (netcon), 2-20

U
unlocked write (netcon), 2-18
user environment, 1-4

V
view menu

all domains, 2-10
individual domains, 2-10

W
windows

Hostview main window, 2-5
netcon(1M), 1-6
Network Console Window, 1-6
SSP Console Window, 1-5
SSP Window, 1-4

X
xntpd daemon, 4-7


